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Linklt Smart 7688 Duo

From Wiki SEEEINHE

Linklt™ Smart 7688 Duo(a compact controller
board) is an open development board based
on MT7688(datasheet

R e

)@ Linie

(http://www.seeedstudio.com/wiki/images/9/90/MT7688 datasheet.pdf) ) and ATmega32u4. The board is
compatible with Arduino Yun sketches and is based on the OpenWrt Linux distribution. The board is designed

especially to enable prototyping of Rich Application IoT devices for smart home or officel'l. As it is compatible well
with Arduino, you can use different features from Arduino Yn and LinkIt Smart 7688 Duol?!. This will help you
build rich applications based on various, robust and compiled Arduino Yun sketches. The board offers you the
memory and packet storage to enable robust video processing. The platform also offers options to create device
applications in Python, Node.js and C programming languages.

(IThis board is only a part of MediaTek Linklt™ Smart 7688 platform which includes other development boards.

[2I0nly one controller can be the main controller of the board at a time.

Note: This page only guides you to get started with this development board. For a complete guide, please refer to
Resources (http://www.seeedstudio.com/wiki/Linklt Smart 7688 Duo#Resources) .

Get One Now
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Features

580 MHz MIPS CPU

Single input single output(1T1R) Wi-Fi 802.11 b/g/n (2.4G)

Pin-out for GPIO, 12C, I12S, SPI, SPIS, UART, PWM and Ethernet Port
32MB Flash and 128MB DDR2 RAM

USB host

Micro SD slot

Support for Arduino APl (ATmega32U4)

Application ideas

» |oT/Gateway Device
= Robotics
= Teaching and learning.

Specification
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Category

MPU

MCU

PCB Size

Memory

Power Source

GPIO

PWM

ADC

External
Interrupts

SPI/SPIS

UART Lite

Feature

Chipset

Core

Clock speed
Working voltage
Chipset

Core

Clock speed
Working voltage
Dimensions
Flash

RAM

USB Power

VCC

Pin Count

Voltage
Pin Count
Voltage

Max. Resolution

Maximum
Frequency@Resolution

Pin Count

Voltage
Pin Count

Set count
Pin numbers
Max. Speed
Set count
Pin numbers

Speed

Set Count

Pin numbers

Max. Speed
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Specification
MT7688AN
MIPS24KEc
580MHz

3.3V
ATmega32U4
Atmel AVR
8MHz

3.3V

60.8 x 26 mm
32MB

128MB DDR2

5V (USB micro-B)
3.3V (Pin Breakout)
3 (MT7688AN)

24 (ATmega32U4)

3.3V
8 (ATmega32U4)
3.3V

16 bits (customizable)

31.25kHz@8-bit, Timer 0 (4 sets)
2MHz@2-bit,122Hz@16-bit, Timer 1

& 3 (4 sets)

187.5kHz@8-bit, 46.875kHz@10-bit,

Timer 4 (6 sets)
12 (ATmega32U4)
3.3V

8 (ATmega32U4)

1 (ATmega32U4)

SO, S1, S2, S3

4 MHz

1

D2, D3

400K

1 (ATmega32U4)

1 (MT7688AN)

P8, P9 (MT7688AN)
DO, D1 (ATmega32U4)

0.5 Mbps (MT7688AN)
0.5 Mbps (ATmega32U4)
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USB Host Set count 1 (MT7688AN)

Pin numbers P6, P7

Connector type Micro-AB

Wi-Fi 1T1R 802.11 b/g/n (2.4G)
Communication Ethernet 1-port 10/100 FE PHY

Pin numbers P2, P3, P4, P5

Micro SD

User Storage  |SD Card SDXC

Hardware Overview

MPU reset button

USB Host

(micro type-AB) MT7688AN & 128MB DDR2

i-fi reset button

M, &

"Smart 7688 B
Duo |

Chip antenna

I-PEX antenna
(requires HW
g configurations)

USB power & MCU reset button
MCU USB port
(micro type-B)

Micro SD slot ATmega32U4

32MB flash

(require hardware
configuration)
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Parts list

Parts name Quantity
Linklt™ Smart 7688 1PC
Manual 1PC

Getting started

Connecting to the embedded operating system

Note: There are two ways described in the manual. In this case, we only show an advanced method (using USB to
Serial adapter) which might seem a little harder. But, you will benefit a lot from it in the long run.

Materials required

= Linklt Smart 7688 x 1

= USB cable (type A to micro type-B) x 1
m USB to Serial adapter x 1

= Jumper wires x 3

On Windows

1. Install PuTTy. PUTTY provides a system console environment using SSH (Secure Socket Shell) to access
development board's operating system.

2. Install Bonjour (https://support.apple.com/kb/DL999?viewlocale=en_US&Ilocale=en_US) Print Service (For
Windows 7, Windows 8, Windows 10).

3. Install driver. If you are using a USB cable based on FTDI chip please download and install its driver from
here (http://www.ftdichip.com/Drivers/VCP.htm) . If you are having problems with the latest driver, try
installing an older version (http://www.ftdichip.com/Support/Documents/InstallGuides.htm) .

4. Next, you will need to connect the Serial to USB cable to Linklt Smart 7688's UART pins as shown in the
following table:

Pin on USB Corresponding Pin to be connected on Linklt Smart
adapter 7688
Pin RX Pin 8
Pin TX Pin 9
Pin GND Pin GND
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5. After connecting the Serial to USB cable, open the device manager and notice the COM port number as
shown in Figure 22. This number may vary on different computers.
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6. Launch the PuTTY terminal and enter the COM port number of the USB device found in the device manager,

click on the Serial radio button, type 57600 in Speed box and click Open, as shown in Figure 23.
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PuTTY Configuration

=

Category:

—|-Session

f Logging

- Terminal
Keyboard
Bell

; Features

“)- Window

' Appearance
Behaviour
Translation
Selection

: Colours

*-Connection
Data
Proxy
Telnat
Rlogin

+-5SH

Senal

Basic options for your PuT TY session

Specify the destination you want to connectto

&enal line peed
COM39 57600

Connection fype:

|Raw Telnet Rlogin (T)SSH

Load. save or delete a stored session

Saved Sessions

Default Settings Load

Save

111

Delete

Close window on exit ’
Always MNever @ Only on clean exit

About || Help

( Open ? Cancel

7.To exit the system console, click the close icon on top right of the PUTTY windows.

On Mac

1. Install the driver if needed. Check the cable manufacturer’ s website for driver requirements on Mac and

installation instructions.

2. Plug-in the cable to PC/Laptop and connect the cable to Linklt Smart 7688.

3. Open a Terminal session.

4. Type Is /dev/cu* in the Terminal. You should see a list of devices. Look for something like cu.usbserial-

XXXXXXXX where XXXXXXXX is usually a random identifier. This is the serial device used to access the system

console. For example:

E/dev/cu .Bluetooth-Modem

E/dev/cu .pablop-WirelessiAP

E/dev/cu .usbserial-A6YMCQBR

5.Use the screen utility to connect to the serial port and set the baudrate to 57600. This is because the

baudrate of the system console is 57600 by default. For example:

6. Now you should be connected to the system console. Press ENTER in the Terminal to bring up the prompt.

You will notice that the prompt has become different from your OS X Terminal application, it is the Linklt

Smart 7688 prompt and it looks like the following:
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7. You are ready to make changes to the Linklt Smart 7688 system through this console.

On Linux

1. Install the driver if needed. Check the cable manufacturer's website for driver requirements on Linux and
installation instructions.

2. Plug-in the cable and connect the cable to Linklt Smart 7688 Duo.

3. Open a Terminal session.

4. Type Is /dev/ttyUSB* in the Terminal. You should see a list of devices. Look for something like cu.usbserial-
XXXXXXXX where XXXXXXXX is usually a random identifier. This is the serial device used to access the system
console. For example:

E$ls /dev/ttyUSB*
:/dev/ttyUSBe

5.Use the screen utility to connect to the serial port and set the baudrate to 57600. This is because the
baudrate of the system console is 57600 by default. For example:

6.Now you should be connected to the system console. Press ENTER in the Terminal to bring up the prompt.
You will notice that the prompt has become a different regular application, it is the Linklt Smart 7688 prompt
and it looks like the following:

7.You are ready to make changes to the Linklt Smart 7688 system through this console.
Running the Blink example
Materials required
Linklt Smart 7688 x 1
USB cable (type A to micro type-B) x 1

USB to Serial adapter x 1
Jumper wires x 3

Get Blink run

1. Power up your board with a micro-USB cable (only connect the USB Power interface, rather than the USB
Host interface).

1TOP
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MEEC

2. Launch PuTTy and connect to system with USB to Serial adapter as shown in previous sections.
3. Type python /loT/examples/blink-gpio44.py and press Enter to run the Blink example.

4. After around 2 seconds, you will notice that the Wi-Fi LED blinks steadily.

5. In the system console, type CTRL + C, this will terminate the example.

Connect to the Internet (Switch to Station mode)

There are two Wi-Fi modes, i.e. AP mode and Station mode. Refer this (https://answers.yahoo.com/question/index?
qid=20061207225409AANCN17) for the differences between them.

1. Power up the board with a micro-USB cable.
2. Open the Wi-Fi connection utility on your computer and connect to the access point named
Linklt_Smart_7688 XXXXXX. XXXXXX is a kind of hardware identifier which varies from board to board.
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-

Currently connected to: +

| 'h' mediatek.inc

. Internet access

Dial-up and VPN A
L

mtkemp Connected 1'.1“

mitkcs

mtkguest ::'1“

Linklt_Smart_7685_1B09F3 o

';ﬁ' Information sent over this nebwork might be visible to
others.

Open Netwerk and Sharing Center

-~

m

("] Connect automatically

3. Open a browser with URL mylinkit.local/ or 192.168.100.1, set the password for root and sign in. Click

Network on the upper right.
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Welcome to MediaTek Linklt Smart 7688 For advanced network configuration, go to OpenWrL.

Sys=tem information Metwork

Platform information

Dewice name

miylinkit

Current IP address

1921681001

Account information

Account

root(default)

Password *

(AR RN Y]
4. Select the Station mode and click Refresh or downward arrow on the right to find the AP to connect to.

After you have selected the AP, enter password if required. Click Configure & Restart to finish as shown below.
Then wait for around 30 seconds to switch mode.

Welcome to MediaTek Linkit Smart 7688 For advanced network configuration, go to OpenWit.

Systemn information

Network setting

O APmoade (® Station mode

Detected Wi-Fi metwork *

mitkemp (83 %) <)

Password

SHOW PASSWORD

CANCEL CONFIGURE & RESTART
—

5. Launch PuTTy and connect to the system with USB to Serial adapter as shown in the previous section.
6. Type ifconfig and find the IP address of inet addr as shown below:
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Note: It will still enter the Station mode after rebooting the system. Press wi-fi button at least 5 seconds to switch
back to AP mode. Note: It will be needed to reboot the embeded OS by using reboot command.

7. Type the IP in a new Tab of browser and you can login to Web user interface to configure the system.
8. Now both the host computer and Linklt Smart 7688 are connected to internet. Type ping
www.mediatek.com in console and you will get:

9. Now you can use internet to configure your system on development board.
Installing Arduino programming environment

This development board has features that are compatible with Arduino. So you can transfer your Arduino code to
7688 platforms which makes prototyping process quicker. In this section, we will show you how to build an Arduino
programming environment.

Download and install Arduino IDE
You can install (https://www.arduino.cc/en/Main/Software) Arduino IDE 1.6.5 on your computer.
Configure Arduino IDE for Linklt Smart 7688 Platform

Installing developed board support package

Arduino IDE 1.6.5 supports third party board integration using the Board Manager tool. Linklt Smart 7688
development board is a plug-in to Arduino IDE and you will need to install the board package so that Arduino
supports Linklt board. Please follow the steps below:

1. In Arduino IDE, on the File menu click Preferences then insert

http://download.labs.mediatek.com/package mtk linkit smart 7688 test index.json to the Additional
Boards Manager URLSs field:
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2. Make sure your computer is connected to the internet. Download
(http://www.seeedstudio.com/wiki/images/1/18/Linklt.zip) Linklt, decompress it and copy the files into the

folder packages which gets same location with file Preferences.txt. Click following red rectangle marked
section to open file location of Preferences.txt.

Preferences

Sketchbook location

C:\Wsers'\He\Docments'\Arduines Browse

Editor language English (English) w (requires restart of Arduine)
Editor fomt mize: |12

Showr verboszs sutput during E compilation Dupln.d

Compiler warmings: |lone w

[A bisplay line nombers

[A Enabls Cods Folding

[Averify cods afeer wplosd

[Juse external editor

[“ICheck for updates sn stertup

[ tpdate zketch files to nmer extension om swre (. pde =% . ine)

[ Save vhen verifying or upleoading
hdditional Bosrds Memager URLs: http //dovnlosd labs mediatek. com/package_mtk linkit_smert_768E_test_index. json i
| SR N I SR L L L T

IE"Wuri\Ht‘.Anllah‘\hnin:\hrduimﬁ".snhnmu tat ]

oK Cancel

3. In the Arduino Tools menu point to Board.

4. There should now be a Linklt Smart 7688 item appearing in the boards list on the Boards Manager and
choose port with COMxx (Linklt Smart 7688 Duo).
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@ Boards Manager é

Type |All &

Intel iGB6 Boards by Inkal
Boards included in this package
Edigsn.

More info

AMEL-Tech Boards by AMEL Technolagy
Baards included in this peckags:
SmartEvarything Fom.

Dnline hals

More info

MediaTak Link1t Smart Boards by Seeed Studio and MediaTek Labs
Boards included in this packege:
LinkIt Smart 7688 Duo.
nline h:ln
Mora info

5. The installation is completed.
Installing Linklt Smart 7688 Duo COM Port Driver

After installing the board package, connect Linklt Smart 7688 Duo to your computer and you should see a USB
serial COM port in the device manager with the following port ID:

= Boot loader COM port: VID=0x0E8D, PID=0xAB00
= Arduino Sketch COM port: VID=0x0E8D, PID=0xABO01

Next, you will need to install drivers depending on your operating system. The steps are:

= For Windows 10, there is no need to install a driver. However, extra steps are needed to ensure Windows 10
recognizes the board. Connect Linklt Smart 7688 Duo to your Windows 10 machine, then quickly press the
MCU reset button twice within 700 milliseconds. The system should now recognize Linklt Smart 7688 Duo as a
USB Serial Device (COMS5). The number 5 may be different on different machines. You only need to do this the
first time the board is connected to your Windows machine.

= For Windows 8, the system may block the driver installation. Follow this link
(https://learn.sparkfun.com/tutorials/disabling-driver-signature-on-windows-8/disabling-signed-driver-
enforcement-on-windows-8) to know how to disable driver signature enforcement on Windows 8. After the
signature enforcement is disabled, follow the steps in Windows 7 below to install the driver.

» For Windows 7, find the Serial COM port INF driver in the following path. You can also install it from here
(http://download.labs.mediatek.com/mediatek_linkit smart 7688 duo-windows-com-port-driver.zip) .

{ARDUINO _IDE_PREFERENCE_LOCATION}Arduino15/packages/Linklt/hardware/avr/0.1.5/driver/linkit_smart_7688.inf

You will find the Arduino preference location at File -> Preferences, see the preference.txt path.
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Right click on the linkit_smart_7688.inf and select install, a security windows appears and click Install this driver

software anyway. This completes the driver installation.

%! Windows Security =

@ Windows can't verify the publisher of this driver software

= Don't install this driver scftware
You should check your manufacturer's website for updated driver software for
your device.

< Install this driver software anyway
Only install driver software obtained from your manufacturer's website or disc.
Unsigned software frcm other sources may harm your computer or steal
informaticn.

w | See details

= For Ubuntu Linux, it should work without installing a driver. Linklt Smart 7688 should be in /dev folder and
mounted as ttyUSBO. The number 0 may be different on each Ubuntu machine.

= For OS X, it is also not required to install a driver, Linklt Smart 7688 Duo is mounted as a serial device
under/dev/tty.usbmodem1413. The number 1413 may be different on each OS X machine.

Demo: A Hello world example

Note: To avoid running out of memory during native application developments, you should setup the native

application development environment in a more powerful host environment that enables you to cross-compile the

executable format of the Linklt Smart 7688 target instead. The following table shows an overview of the Linklt
Smart 7688 programming languages and the related development environments on host computer.
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Programming Tools and libraries Applications Host platforms
language suspported
C ilati Syst 0> X
C/C+ ross compilation ystem .
toolchain programming Linux
Prototyping oS X
Python runtime on .
Python Linklt Smart 7688 | Network Arduino )i windows
bridge library
) ) Prototyping OS X
Node.is Node.js runtime on
J Linklt Smart 7688 Network Linux Windows

A Hello world example in Python

1. Use FileZilla and refer to this tutorial (https://wiki.filezilla-project.org/FileZilla_Client Tutorial (en)), the
server IP(replace host name) address is the inet addr found in previous Switch to Station mode
(http://www.seeedstudio.com/wiki/Linklt Smart 7688 Duo#Switch to Station_mode) section, the username is
root and password is password you set in that section.

2. Open a text editor, copy and paste the below example code and save it as helloworld.py.

3. Copy the file helloworld.py into system on target development environment (Linklt Smart 7688) with
FileZilla, place it under the folder root.

4. Launch PuTTy and connect to system with USB to Serial adapter.

5. Set working directory to /root and enter python helloworld.py to execute.

6. Now you can see Hello World! printed in console.

A Blink example on Arduino

On host computer(Arduino side)

The MCU side is written as an Arduino sketch. In this example, the sketch simply listens to the command sent from
the MPU (Linux) side and switches the on-board LED accordingly.

1. First, connect the Linklt Smart 7688 Duo to your PC, then open Arduino IDE and paste the following sketch
code into the IDE:

Evoid setup() {
Serial.begin(115200); // open serial connection to USB Serial port (connected to your computer)
Seriall.begin(57600); // open internal serial connection to MT7688
// in MT7688, this maps to device
pinMode (13, OUTPUT);

i
wvoid loop() {
int ¢ = Seriall.read(); // read from MT7688
(c !=-1) {
(c) {
‘e': // turn off D13 when receiving "@"
digitalWrite(13, 0);
break;
‘1': // turn off D13 when receiving "1"
digitalWrite(13, 1);
break;

2. Then choose the correct COM port from the IDE (check your device manager) by clicking Tools -> Port.
3. Upload the sketch to the board. Note the board is not blinking yet — you will need to write a program in the
http://lwww .seeedstudio.com/wiki/Linklt_Smart 7688 _Duo 17/19
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Linux side to make it blink, which is the next step.

F

sketch_oct1da | Arduino 1.6.5 =6

File Edit Sketch Tools Help

Llpload Using Programmer

sketch_oct1da g

wvoid zetupl) |

FEoan MTTR22, this maps o device
pinMode(12, OUTEUT );

vold locpl) {
int c = Sexiall _read(); P ocead from WMI7A52
if (o l=-10 ]
awitchic) |
case '0': FEoturn off D13 when receiving "0"
digitalWrite{ls, U);
hreak;
case '1': FEoturn off D13 when receiving "1
digitalWrite(ls, 1);

hreak;

Linklt Smart

Sexiel bezinf1152000: FF ozen serial conmection to USE Serial port (connec
Seriall begin(5PR00); AF open internal serial connection to MT7RES

Duo or COMA

On development board(Linux side)

1. Use a text editor of your choice and create a new file(a Python file), then copy the following code and save

it

iimport serial

iimport time

is = None

def setup():

iglobal s

# open serial COM port to /dev/ttySe, which maps to UART@(D@/D1)
W the baudrate is set to 57608 and should be the same as the one
kT specified in the Arduino sketch uploaded to ATmega32U4.

s = serial.Serial("/dev/ttySe", 57600)

def loop():

# send "1" to the Arduino sketch on ATmega32U4.

# the sketch will turn on the LED attached to D13 on the board
:s.write("l")

itime.sleep(1)

# send "@" to the sketch to turn off the LED

is.write("0")

itime.sleep(1)

if __name__ == ' _main_ ':

isetup()

while True:

Loop()
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2. Execute this Python program in the system console — this program basically writes string of 1 and 0 to the
/dev/ttyS0O port which maps to Serial1 interface in Arduino. The Arduino sketch that was uploaded in the
previous section will receive the string and then blink the on-board LED accordingly.

You can now extend the Arduino sketch to drive other devices such as PWM, 12C devices and synchronize the states
by extending the command messages between Arduino and the Linux side. If more peripheral types need to be

included, you can use some external libraries to implement the communication protocol. One such protocol -
Firmata is described in the following section.

Resources

= Hardware Schematic files (http://www.seeedstudio.com/wiki/images/6/6e/Hardware_Schematics.zip)
= Manual (http://www.seeedstudio.com/wiki/images/1/17/Manual.zip)

= OpenWrt (http://wiki.openwrt.org/doc/howto/user.beginner)
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